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Contents of Package:

Package Contents

If any of the above items are missing, please contact your reseller.

System Requirements:
Local Area Network:  10Base-T Ethernet or 100Base TX Fast Ethernet
Wireless Local Area Network:  IEEE 802.11b Wireless LAN (Wireless Internet
Camera only)
Recommended:  PC or Notebook to Access the  Internet Camera
Web Configuration

• Java Enabled and Compliant Web Browser
• CPU:  Pentium II, 266 MHz or above
• Memory Size: 32 MB (64 MB recommended)
• VGA card resolution: 800x600 or above

• One Internet Camera
• Two External Wireless Antennas (Wireless Internet Camera only)
• One Installation CD-ROM
• One AC power adapter
• One Camera Stand
• One Category 5 Ethernet Cable
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Introduction

System Requirements (continued):

IPView Configuration
• Windows XP, Me, 2000, 98SSe or 98
• CPU:  Pentium II, 350 MHz or above
• Memory Size: 128 MB (256 MB recommended)
• VGA card resolution: 800x600 or above

The Internet Camera connects directly to an Ethernet, Fast Ethernet, or 802.11b (DCS-
1000W only) Network. It is different from the conventional PC Camera because the
Internet Camera is a stand-alone system with a built-in CPU and web server providing a
low cost solution that can transmit high quality video images for monitoring. The Internet
Camera can be accessed remotely, and controlled from any PC/Notebook over the Intranet
or Internet via a web browser. The simple installation procedures and web-based inter-
face offers easy integration to your network application environments coupled with many
applications such as remote monitoring for a cost-effective solution.

Simple to Use
The Internet Camera is a standalone system with built-in CPU requiring no special
hardware or software such as PC frame grabber cards. The Internet Camera supports
both ActiveX mode for Internet Explorer and Java mode for Internet Explorer and
Netscape Navigator. Therefore, all that is required is a computer with a web browser
software such as Internet Explorer 4.0 or above or Netscape 4.0 or above. Just plug
and view the picture from your Internet Camera with a valid IP Address.

Supports a Variety of Platforms
Supporting TCP/IP networking, SMTP e-mail, HTTP and other Internet related
protocols, the Internet Camera can be utilized in a mixed operating system environment
such as Windows, Unix, and Macintosh. It can also be integrated easily into other
Internet/Intranet applications because of its standards based features.

Features & Benefits
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Wired and Wireless Network Support

The Internet Camera supports both wired and wireless transmission (DCS-1000W only,
the DCS-1000 supports wired transmittion only) providing the advantage of mobility,
flexibility and high-speed of wireless LAN based technology, IEEE 802.11b, to transform
the Internet Camera into a total solution for your network. There are three modes available,
configured from the slide switch on the rear panel:

• LAN (Local Area Network Only)
• LAN/WLAN (Local Area Network and Wireless Local Area Network.  Both can

be accessed at the same time) (Wireless Internet Camera only)
• WLAN (Wireless Local Area Network) (Wireless Internet Camera only)

Broad Range of Applications
With today’s high-speed Internet services, the Internet Camera can provide the ideal
solution for live video images over the Intranet and Internet for remote monitoring. The
Internet Camera allows remote access from a web browser for live image viewing and
allows the administrator to manage and control the Internet Camera anywhere and any
time in the world. Apply the Internet Camera to monitor various objects and places such
as homes, offices, banks, hospitals, child-care centers, amusement parks and other
varieties of industrial and public monitoring. The Internet Camera can also be used for
intruder detection, capture still images and video images for archiving and many more
applications.

Connection to External Devices
Supporting auxiliary Input/Output connectors, you can connect the Internet Camera  to
a variety of external devices such as IR-sensors, switches and alarm relays. One can
combine with programmable alarming facilities to develop a variety of security applications
that are triggered on alarm-based events. The Internet Camera provides up to two in/out
external devices for connectivity.

Remote Monitoring Utility
Powerful IPView application assigns administrator with a pre-defined user ID and
password who can modify the Internet Camera settings from the remote site via Intranet
or Internet, and upgrade remotely over the network for added convenience. Users are
also allowed to monitor the image, record the image to a hard drive, and take snapshots.

Web Configuration
Applying a standard web browser, administrators can configure and manage the Internet
Camera directly from its own web page via the Intranet or Internet. Up to 64 user names
and passwords are permitted, with privilege setting controlled by the administrator.
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Connections

Network Cable Connector
The Internet Camera’s rear panel features an RJ-45 connector for connections to 10Base-
T Ethernet cabling or 100Base-TX Fast Ethernet cabling (which should be Category 5
twisted-pair cable). The port supports the NWay protocol, allowing the Internet Camera
to automatically detect or negotiate the transmission speed of the network.

DC Power Connector
The DC power input connector is located on the Internet Camera’s rear panel and is
labeled DC 5V with a single jack socket to supply power to the Internet Camera.

Reset Button
Reset will be initiated when the reset button is pressed once and Power LED begins to
flash.

Factory Reset will be initiated when the reset button is pressed continuously for three
seconds or when Power LED begins to light up. Release the reset button and the Power
LED will begin to flash indicating that the Internet Camera’s settings are reverting back
to the factory settings. When factory reset is completed the Internet Camera will be set
to default on channel 11 and EES-ID is set as “NULL String.” (This default setting will let
the Internet Camera connect to ANY access point on the infrastructure network.) The IP
address will also return to the default setting of 192.168.0.20.

Antenna Connectors
(DCS-1000W only)

Ethernet Cable
Connector

Reset Button

Slide Switch
(DCS-1000W only)

DC Power Connector

I/O Connector
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Slide Switch (DCS-1000W only)
The slide switch permit user’s to determine the type of network
communication media for the Internet Camera and is positioned on the rear
panel. The three settings are as follows:

• LAN (Local Area Network Only)
• LAN/WLAN (Local Area Network and Wireless Local Area Network.

Both can be accessed at the same time.)
• WLAN (Wireless Local Area Network Only)

I/O Connector
There are four I/O connectors, two for input and two for output situated on the
rear panel. The I/O connectors provide the physical interface to send and receive
digital signals to a variety of external alarm devices. Please refer to the User’s
Guide appendix for detailed information.

Antenna Connector
There are two SMA type antenna connectors located at the rear panel of the Internet
Camera  providing connection for two high sensitivity antenna included with the device.

Connections (continued)

Bottom Panel

Bracket Cavity

Bracket Cavity
Located on the bottom panel of the Internet Camera, the bracket cavity is used to
connect the camera stand onto the Internet Camera by attaching the screw head on
the camera stand into the mounting cavity of the Internet Camera.
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LEDS
LED stands for Light-Emitting Diode.

Power LED
The Power LED is positioned on the right side of the Internet Camera lens
while facing the Internet Camera. Steady blue confirms that the Internet Camera
is powered on.

Note:
There are three settings for the Power LED to control the light illumination for
monitoring purposes:  Normal / Off / Dummy. Please refer to the Web
Configuration section for detailed information and usage.

LAN/WLAN LED  (Wireless Internet Camera only)
The LAN/WLAN LED is positioned on the right side of the Internet Camera’s,
lens while facing the Internet Camera. It is located to the right of the Power
LED

Steady orange confirms good connection to the LAN or WLAN.

Dependent on the data traffic the LED will begin to flash to indicate that the
Internet Camera is receiving/transceiving from/to the LAN or WLAN network.

Note:
There are three settings for the LAN/WLAN LED to control the light illumination
for monitoring purposes: Normal / Off / Dummy. Please refer to the Web
Configuration section for detailed information and usage.
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1. Attach Wireless Antenna (Wireless
Internet Camera only)

From the rear panel of the Internet Camera,
screw the 2 external antennas that came with
DCS-1000W into the antenna connector.

2. Configure Network Communication
(Wireless Internet Camera only)

From the rear panel of the Internet Camera select
the desired network communication for the Internet
Camera from the Slide Switch. Position the Slide
Switch to the setting required for either LAN or LAN/
WLAN (Wireless Internet Camera only) position.

Please refer to the Physical Description section
for detailed information.

3. Connect an Ethernet cable

Connect an Ethernet cable to the network
cable connector located on the Internet
Camera’s rear panel and attach it to the
network.

4. Attach the external power supply

Attach the external power supply to the DC power
input connector located on the Internet Camera’s
rear panel and labeled DC 5V and connect it to
your local power supply.

Note:
The LED indicator labeled Power will illuminate to
indicate a proper connection to the power supply.

Hardware Installation
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The Internet Camera comes with a camera
stand with a swivel ball screw head that
can be attached to the Internet Camera
bottom bracket cavity. Attach the camera
stand to the Internet Camera and station it
for your application. There are three holes
located in the base of the camera stand
allowing the Internet Camera to be mounted
on the ceiling or any wall securely.

Connecting the Internet Camera to the Camera Stand

Security
To ensure the highest security and prevent unauthorized usage of the Internet
Camera, the Administrator has the exclusive privilege to access the System
Administration setting to allow users the security level of entry and authorize
privileges for all users. The Internet Camera supports multi-level password
protection/access to the Internet Camera that can be restricted to defined
users who have a “User Name” and “User Password” which is assigned by
the Administrator.

The administrator can release a public user name and password so that when
remote users access the Internet Camera they will have the right to view the
image transmitted by the Internet Camera.

Note:
When the Internet Camera is used for the first time it is highly recommended
that the Administrator set the “Admin ID” and “Admin Password” to constrain
user access to the Internet Camera since the Default settings are Null String
(no password). Once the ID and Password are defined only the Administrator
has the access to the management of the  Internet Camera. This procedure
should be done as soon as possible since the security features of the Internet
Camera will not be enabled until the “Admin ID” and “Admin Password” is
defined.
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Using the Internet Camera as a
Security System

D-Link's IP Camera System is one of the most cost effect
security solutions today. Both the DCS-1000 Wired model
and DCS-1000W Wired/Wireless model have input/output
controls for interfacing with security systems.

On the back of the Camera you will find an 8-position
connector. This connector has 2 input triggers for security
sensors and 2 output triggers for security alarms.

Security sensors for input are available as Passive (low-
current/low voltage) sensors or Active (powered) sensors.

Because of power limitations of the DCS cameras and its compatibility with Power over
Ethernet standards the sensor power requirement must be obeyed for proper operation.
We have listed Passive and Active components that will interface with the DCS family of
Cameras. Passive components must not exceed 5V 100mA. Active components must
be self-powered by an external power source.

For the demonstration below a D-Link DCS-1000 was purchased from www.dlinkshop.com
, the security equipment was purchased from www.smarthome.com, and some cable
accessories from a local hardware store.

Materials
• DCS-1000
• 2 Ethernet Cables & Ethernet Switch/Internet Router
• An Ethernet based PC to configure system
• Internet Name Server and E-Mail Server to send capture information
• 10FT. 24Gauge
• 1 light current power distribution block for 12V power
• 30W Weatherproof Siren
• High Sensitivity DPDT relay (allows 5V camera to turn on 12V siren)
• Mini-Magnetic Contact Switch (commonly used for doors or windows)
• PIR Motion Detector

You will need some simple tools like wire cutters/strippers and the appropriate screwdriver
for mounting and distribution block setup.

Everything less the camera cost about $97 US Dollars including shipping.



12

Basic Hardware Set-up Diagram
The diagram below shows the hardware configuration for 1 Active Sensor (PIR Motion
Sensor), 1 Passive Sensor (Magnetic Switch), and 1 output (For Relay) for a siren.

Passive Component Notes!!!
Only simple magnetic or contact switches can be used for Passive components. This
limitation is by the camera only supplying 5V and less then 100mA current to those
circuits. Distance for passive components is limited by a viewable camera range of about
25 Ft using 26GA wire.

Active Component Notes!!!
A separate power supply is needed for these devices. In order to choose the proper PS.
The total current draw by all the components cannot exceed the Max supplied by the
power supply.

Example
Our PIR Motion Detector = 17 mA  = .017A
Our Relay = 60 mA = .06A
Siren = 200mA = .20A
Total : .277A

Purchased DC power adapter 12V DC 1.2A Max to cover all Active Sensors and Siren,
with room to grow.
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Camera Configuration
Follow the instructions for  setting up your wired or wireless camera. If the camera is for
home use and is behind an Internet router,  additional set-up notes  for  your  router can
be found on www.dlink.com.

Once logged into the camera on the main menu click/select trigger and the following
screen will appear.

These fields control Input Trigger 1 and Trigger 2. Each Input Trigger can trigger either or
both Output triggers.

SMTP Server Address: Name or IP address of a Mail Server that camera can use to send.
Sender E-Mail: Name of the Camera that sent the mail
Receiver E-Mail: Name of person to receive pictures when sensors are activated
Sending Interval: The time between additional sequences of pictures are taken when
sensors activated
Sending Times: The number of times the camera takes additional sequences of pictures
based on Sending Interval.
Trigger I/O: Enable Output trigger for the specified input trigger
Output # Time: How long the output trigger is activated if the sensor is activated. (ie.
How long should the siren ring?)

INPUT TRIGGER RESPONSE NOTES!!!
The camera will take a sequence of pictures and the output trigger is activated when
there is a change which will open or close the sensor. Example: The magnetic switch is
opened, a sequence is sent and the siren goes off. The switch is then closed, an additional
sequence is sent and the alarm goes off.  The camera is designed this way so if there is
an intrusion, the intrusion is detected if the intruder simply opens then closes the entrance.
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Additional Component Listing for Use with the Internet
Camera
All components listed below can be found at www.smarthome.com

Passive Components
Glass Break Sensor PN: 5150w - Sentrol Inc.  Any contact switch or pressure switch not
exceeding 100mW current draw. Examples @ http://www.smarthome.com/
seccontacts.html

Active Components
Coral Plus Temperature Compensated PIR Detector - Visonic Ltd.Duet Dual Microwave/
IR Motion Detector - Visonic Ltd.Bravo 6 Dual PIR Detector - DSC Security ProductsAny
active security sensor that uses external power and a separate normally closed N/C
circuit for detection: Examples at http://www.smarthome.com/secpirmotion.html

Power and Relay Components
ELK Products Inc. ELK-924 Single 12V to 120V relay switch. DVE Power Supply 12V
1.2A. More can be found on http://www.smarthome.com/powersupply.html

Alarm Components
Universal SS30 30W 8Ohm SirenMore visual and audible alarms can be found @ http://
www.smarthome.com
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Software Installation
Web Configuration
The Internet Camera must be configured through its built-in, Web-based
Configuration.

From the web browser, enter the default IP address (192.168.0.20) to access
the Welcome screen of the Internet Camera. To configure your Internet Camera
type “http://192.168.0.20” in the address box of your favorite Web Browser.
The number is the default IP address of your Internet Camera. Press Enter.

Note:
The PC’s IP address must correspond with the Internet Camera’s IP address
in the same segment (i.e. PC=192.168.0.5, Camera=192.168.0.20) for the
two devices to communicate. For instructions on how to do this, please
access instructions for installing any of the D-Link Broadband Gateway
products from support.dlink.com/products. The DI-713 or DI-714 are good
products to use as an example as their Quick Install Guides are the most up-
to-date.

Main Menu Image
After the default IP address is entered from the browser, the Internet Camera
Home screen will appear with a still image. There will be three options to choose
from to set-up and view your Internet Camera and they are as follows:

View Image – ActiveX Mode
View Image – Java Mode
System Administration
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System Administration
Click on “System Administration” from the Home screen to access the settings required
for the Internet Camera.

There will be several options in the System menu bar to choose from to set
your Internet Camera and they are as follows:

System
Image
Users
Date/Time
Trigger
Information
Tools
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System Administration

System Administration – System
The System menu contains commands for settings that are required for inputting
key details to set-up the Internet Camera for operation.

Click on System in the system administration menu bar and the System screen
will appear as illustrated below:
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Camera Name:

This field is used for entering a descriptive name for the device.
The default setting for the Camera Name is CS-xxxxxx, where xxxxxx is the
last six digit of the MAC Address. The maximum length is 32 (Printable ASCII).

Location:
This field is used for entering a descriptive name for the location used by the
Internet Camera.

Admin:
This field is used for entering the Administrator ID along with the password to
access the System Administration settings. Be sure to enter the password
twice to confirm the details once in the Admin Password field and again in the
Confirm Password field.

The default setting for Admin is blank (Null String) you need to key in the
Admin ID with a maximum length of 12 (Printable ASCII) characters and enter
the Admin Password with a maximum length of 8 (Printable ASCII) characters.

It is highly recommended to set the Admin ID and Admin Password as soon
as possible to ensure the highest possible security.

IP Assignment:

There are two options to select from the IP Assignment either Manually Assign
or Assign Automatically Using.

Manually Assign
You can click “Manually Assign” and directly enter the IP address.

Important Information
Access to the Internet Camera is gained by assigning a proper IP
Address.  Please make sure to use a vacant IP address when you
assign the IP Address for the Internet Camera.  This will prevent
errors from occurring if the IP Address is overlapped.
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The default settings are as follows:
Default IP – 192.168.0.20
Subnet Mask – 255.255.255.0
Default Gateway – 0.0.0.0

DNS IP Address:
DNS (Domain Name System) server is an Internet service that translates domain
names (ie. www.dlink.com) into IP addresses (ie. 192.168.0.20). The DNS IP
address can be received from your ISP. Enter at least one DNS IP Address.

Wireless Interface (for Wireless Internet Camera only):
Connection Mode:
Use the Connection Mode to determine the type of wireless communication for
the Internet Camera. There are three choices of Infrastructure mode, 802.11
Adhoc mode and Adhoc mode. The default setting for the Connection Mode is
Infrastructure.

Note:
Keep in mind that after setting the Wireless Interface make sure that the Slide
Switch on the rear panel is positioned to either LAN/WLAN or WLAN setting for
the wireless communication to take effect.

Assign Automatically Using

If your network is using RARP, BOOTP or DHCP server you can click Assign
Automatically Using and click on RARP, BOOTP or DHCP.  Under this setting
the Internet Camera will automatically assign an IP address from RARP, BOOTP
or DHCP server.  Each time the Internet Camera starts up, be sure the RARP,
BOOTP or DHCP server is setup to assign a static IP to your Internet Camera.

If your application requires direct connection from an ADSL modem through the
Internet Camera’s RJ-45 LAN port and you also have an ISP PPPoE account,
the click on PPPoE and enter the Service Name, User ID and Password into
the respective fields.

The Internet Camera will get an IP address from the ISP each time it starts up.

Important
It is recommended that you do not use an Automatically Assigned IP address as it
may be difficult to determine the IP address of the unit after the IP address has been
asssigned.  It is recommended that an IP address be assigned manually.
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Note:
The Internet Camera supports two ad-hoc modes (802.11 ad-hoc mode and
proprietary ad-hoc mode).  Which option of the ad-hoc mode required depends
on the operation of your Internet Camera.  It depends on which ad-hoc mode is
supported by your wireless card driver on the PC/Notebook. Some drivers
supports both modes, however, some drivers support only one of the modes.
The names of each ad-hoc mode may not be consistent between each wireless
card vendor therefore you may need to try each of the ad-hoc modes (802.11
mode and proprietary mode) and select the mode that can communicate with
each other.

Wireless Channel: (for Wireless Internet Camera only)
The pull down menu provides the wireless channel for communication. A
“channel” is a range of frequencies to be used in communication between the
Internet Camera and Access Point in infrastructure mode or the Internet Camera
and PC/Notebook in Ad-hoc mode. Select the appropriate channel from the list
provided depending on the regulatory region in which the unit is sold. The default
setting is channel 11.

The default Network Name is a blank space (NULL String); this default setting
will let the Internet Camera connect to any access point under the infrastructure
network mode.

To connect the Internet Camera  to a specific access point on the network
make sure that you set the ESS-ID of the Internet Camera to correspond with
the access point’s ESS-ID. Type any string up to 32 characters long (spaces,
symbols, and punctuation are not allowed) in the Network Name box.

To connect the Internet Camera to an Ad-hoc wireless workgroup make sure
that you set the same wireless channel and ESS-ID to match with the PC/
Notebook wireless channel and ESS-ID for direct wireless communication under
the Ad-hoc wireless workgroup (ad-hoc and 802.11 ad-hoc modes).

Network Name: (for Wireless Internet Camera only)
This field is used to setup which wireless network (ESS-ID Extended Service
Set ID) DCS-1000W is to be connected for communication. The ESS-ID is a
unique identifier shared among all points in a wireless network environment.
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HEX input format: (for Wireless Internet Camera only)
Hex format causes each pair of characters you type to be interpreted as an
eight-bit value in hexadecimal (base 16) notation. Only the digits 0 through 9
and the letters A through F (in upper or lower case) are valid. To setup 64-bit
WEP key, input 10 HEX format, for example, ‘3132333435’, this is the same
with ASCII input ‘12345’. To setup 128-bit WEP key, input 26 HEX format, for
example, ‘31323334353637383930313233’, this is the same with ASCII input
‘1234567890123’. These character counts result in bit counts of 40 and 104,
respectively; the Internet Camera will automatically pad your input to a bit count
of 64 or 128.

On the Confirm WEP Key field, input the same characters as the Encryption
Code field.

Make sure the Encryption Code is the same with the access point’s encryption
code that the Internet Camera is to be connected under Infrastructure mode.
Your PC/Notebook’s encryption code also needs to be setup the same with the
Internet Camera’s encryption code under either Infrastructure mode or Ad-hoc
mode.

Encryption WEP Key: (for Wireless Internet Camera only)
Wireless network communications are easily intercepted. WEP (Wired
Equivalent Privacy) is an encryption method specified by the IEEE 802.11b
standard to make any intercepted communications extremely difficult to interpret
by unauthorized parties.

To enable WEP Encryption, first decide which WEP key format will be applied.
Click on ASCII or HEX check box to select input format as ASCII format or HEX
format, and then input the WEP key. To Confirm the WEP key you must enter
the data once again in the Confirm WEP Key field.

ASCII input format:  (for Wireless Internet Camera only)
ASCII format causes each character you type to be interpreted as an eight-bit
value. All unaccented upper- and lower-case Western European characters
that can be input through your keyboard’s typing zone are valid. To setup 64-bit
WEP key, input 5 ASCII characters, for example, ‘12345’. To setup 128-bit WEP
key, input 13 ASCII characters, for example, ‘1234567890123’. These character
counts result in bit counts of 40 and 104, respectively; the Internet Camera will
automatically pad your input to a bit count of 64 or 128.
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Dummy
Power - Steady On of the LED indicator.
LAN/WLAN - Steady On of the LED indicator with random
flashing.

The default setting for the LED control is Normal. When you have configured
the LED control the correct illumination will set in after 1 minute.
Note:
This function is built-in to the LED indicators to add extra capabilities. The three
options allow the Administrator to configure and camouflage the illumination for
the LED indicator to falsify the monitoring status. In Normal Mode the LED
indicator functions normally. Under Off Mode the LED indicators are both off,
however, it is still monitoring the activity. In Dummy Mode the LED indicators
operate in monitoring condition but monitoring activity is off or on.

The default setting for the Encryption Key is Disable. Therefore, to secure the
wireless transmission be sure to Enable the Encryption Key by entering the
relevant data.

Note:
Carefully input the Encryption Code, any error setting the code will cause the
communication link to fail.
LED Control:
The LED control allows you to setup the LED illumination as desired. This
feature provides the flexibility when surveillance activity is ON.

There are three options as follows:
Normal

Power - Steady On of the LED indicator.
LAN/WLAN - Steady On of the LED indicator. When LAN/WLAN
activity is present the LED indicator will flash steadily.

OFF
Power - LED indicator is off
LAN/WLAN – LED indicator is off

Note: The WLAN LED is only available on the Wireless Internet
Camera

Loading ActiveX From:
This field is used to specify the location of Xplug Control (ActiveX) plug-in
program. Enter the information as required in .ocx format, for example:
http://www.<your company>.com/xplug.ocx where <your company> must
be replaced with your company’s DNS server.
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The Transfer Image field allows settings to open a second port for the Internet
Camera to transfer images. The default Port “8481” is open image transfer and
you can define a second port similar to above.

Save/Cancel:
After making sure all settings in the System are correct, click on the Save icon
to store the settings in the Internet Camera. You can alternatively click on the
Cancel icon to restore all settings to the values last saved to or retrieved from
the Internet Camera.

System Administration - Image
The Image menu in the system administration contains commands to provide
the settings for the images captured by the Internet Camera.

Click on Image in the system administration menu bar and the Image screen
will appear as shown in the following illustration:

Instructions for installing ActiveX from the driver CD is included in this manual.
Refer to the section labeled Software Installation.

You can open the second port for each Internet Camera from port 81 to Port 85
as illustrated below:

Internet Camera 1 – IP 192.168.0.101, second web port 81
Internet Camera 2 – IP 192.168.0.102, second web port 82
Internet Camera 3 – IP 192.168.0.103, second web port 83
Internet Camera 4 – IP 192.168.0.104, second web port 84
Internet Camera 5 – IP 192.168.0.105, second web port 85

You also need to setup your DSL gateway for Port Mapping.

Port 81 map to 192.168.0.101
Port 82 map to 192.168.0.102
Port 83 map to 192.168.0.103
Port 84 map to 192.168.0.104
Port 85 map to 192.168.0.105

The Web Server field allows settings to open a second port for the Internet
Camera.  This will permit users IP Sharing Gateways to support multiple Internet
Cameras.  By default Port 80 is always opened for Internet Camera Web Server
access.  Select Yes and input the second port value.

Open a second port:
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Video Resolution:
Select the desired video resolution format ranging from 160x112, 320x240
(default) or 640x480

Compression Rate:
Select the desired compression rate from five levels from very low to very high.
Higher video compression rates will generate more compact file sizes with
less video quality, and lower video compression will result in larger files with
higher video quality. The default setting is Medium.

Frame Rate:
Select the frame rate desired with the default setting at Auto for optimal frame
rate. A setting of Auto will get best results.

Brightness Control:
Adjust the brightness level with the default setting of 64.

Contrast Control:
Adjust the contrast level with the default setting of 64.

Hue Control:
Adjust the hue level with the default setting of 64.
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Light Frequency:
Adjust the light frequency to suit your area of operation.  The options are either
50 Hz or 60 Hz (default).

50 Hz and 60 Hz variants are available to accommodate the different light
frequencies found in USA (60 Hz) and Europe (50 Hz)  to ensure better image
quality.

Save/Cancel:
After making sure all settings in the System are correct, click on Save  to store
the settings in the Internet Camera. You can alternatively click on Cancel to
restore all settings to the values last saved to or retrieved from the Internet
Camera.

System Administration - Users
The User options menu contains commands to allow the system administrator
to assign legal users who are permitted to monitor the Internet Camera from a
remote site.

Click on Users in the system administration menu bar and the Users screen
will appear as illustrated below:

Add User:
User Name:
Enter the user name in this field.

A maximum of 64 user names are allowed, however each user name must be
different. Each user name can be used as a group.  For example, if the User
Name is Guest and the User Password is Guest anyone can access the
Internet Camera using this information. The maximum length for the User Name
is 12 characters (Printable ASCII).
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User Password:
Enter the user’s password you want to assign to the specific user-name.
The maximum password length is 8 characters (Printable ASCII).

I/O Output Control:
The Administrator has the authority to give permission to control the I/O Output
Control to users by selecting Yes or No to activate the I/O Output control.

To add a new user name, input the necessary information first and click on
Add.
Delete User:
Select the user you wish to delete from the pull down menu and click on
delete icon.

Important Information
  Once the administrator has configured the Internet Camera Users, any
  user will be required to enter a login password to access the video image
  from the Internet Camera. The password dialog box is illustrated below.

                        

System Administration – DateTime
The DateTime menu contains commands for setting the Internet Camera’s
time and date requirements to provide correct information to users who might
be thousands of miles away in a  remote site. The two options in the DateTime
menu bar are Synchronized with Time Server or Set Manually.
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Click on DateTime in the system administration menu bar and the DateTime
screen will appear as illustrated below:

DateTime:
Select Synchronized with Time Server and the time will be based on the
GMT setting. The time will be synchronized every 10 minutes. This is also the
default setting for the Internet Camera.

IP Address:
Enter the IP Address of the Time Server in this field.

Protocol:
Two options of NTP or Time are available for your selection to link with the
Time Server. The default setting is NTP.

TimeZone:
The System administrator must select the time zone for the region. Please
refer to the appendix for the time zone selection table.

To set the DateTime manually select Set Manually. The system administrator
must then enter the Date and Time in the respective field manually.

When you select Set Manually, each time the Internet Camera is powered off
and on you must re-enter the details once again due to time lost.
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Note:
Please find below the NTP server web addresses, for your reference, to set
the time server.

http://www.eecis.udel.edu/~mills/ntp/clock1.htm
http://www.eecis.udel.edu/~mills/ntp/clock2.htm

Save/Cancel:
After making sure all settings in the System are correct, click on the Save icon
to store the settings in the Internet Camera. You can alternatively click on the
Cancel icon to restore all settings to the values last saved to or retrieved from
the Internet Camera.

System Administration – Trigger
The Trigger menu contains commands for the I/O Trigger connectors providing
the physical interface for 2 digital outputs and 2 digital inputs that are used for
connecting a diversity of external alarm devices to the Internet Camera such
as IR-Sensor and alarm relay devices.

Click on Trigger in the system administration menu bar and the Trigger screen
will appear as illustrated below:
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The default setting for the I/O Trigger functions is “disabled.”  You must enable
the I/O Trigger first before the Triggers will perform.
There are two options to select from the Trigger screen I/O Input 1 Trigger
and I/O Input 2 Trigger.

I/O Input 1 Trigger:
Select “Send e-mail attached with image” and enter the relevant information
such as the SMTP Server Address, Sender e-mail Address, Receiver e-mail
Address, Sending Interval and Sending Times.

SMTP (Simple Mail Transfer Protocol) is a protocol for sending e-mail
messages between servers. You need to input the mail server address
in this field.
Sender e-mail is the person’s e-mail address that will be sending the
e-mail.
Receiver e-mail is the e-mail address of the person that will receive
the e-mail.
Sending Interval is the period of time between each e-mail being sent
to the receiver. If the setting is at 10 seconds, a new e-mail will be sent
in 10 seconds interval to the receiver.
Sending Time is the number of times the e-mail will be sent to the
receiver before it terminates.

Select “Trigger I/O Output” and enter the setting for the duration of the output
device for Output 1 time and Output 2 time in seconds.

I/O Input 2 Trigger:
Refer to “I/O Input 1 Trigger” information above.

Save/Cancel:
After making sure all settings in the System are correct, click on the “Save”
icon to store the settings for the Internet Camera. You can alternatively click on
the “Cancel” icon to restore all settings to the values last saved to or retrieved
from the Internet Camera.

Warning

Please refer to the appendix for detailed information  regarding the I/O Connector.

When connecting other devices through the I/O connectors, please make
sure the maximum current of 100mA is strictly observed.  Any failure to do
so might cause a loss of power and possibly cause serious damage to the
Internet Camera.
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System Administration - Upload

The Upload menu contains commands for FTP server, time schedule and
manual operation settings.

Click on Upload in the system administration menu bar and the Upload screen
will appear as illustrated below:

There are three options to select from the Upload screen: FTP Server, Time
Schedule and Manual Operation.

FTP Server:
There are 6 basic settings for your FTP server.

• Host Address: The IP Address of the target FTP server.
• Port Number: The standard port number for FTP server is Port 21 and

it's also the default setting. If the FTP server uses a specific port, please
confirm with the IT manager.
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• User Name: Enter the user name in this field.
• Password: Enter the user password in this field to login the FTP server.
• Directory Path: It is recommended to leave this field blank.  By default,

the path will be the ftp root directory.  Optional: Enter an existing folder
name in  this field, and the images will be uploaded to the given folder in
the ftp root directory.

• Passive Mode: This function depends on your FTP server. Please check
with your IT manager if the FTP server uses passive mode. The default
setting is No.

Time Schedule:
Select Upload image to FTP server and enter the relevant information such
as the schedule, image frequency and base file name.

•     Schedule: You can 1.) Choose Always to upload the images to FTP
      server always, or 2.) Set the Schedule to manage the uploading task.
      In the Schedule option, you can set the Day and Time Period option.
•     Image Frequency: There are two ways to set the image frequency: 1.)
      Set Auto/1/2/3 frames per second, or 2.) Set the time in seconds for
      every one frame.
•  Base File Name: Enter the file name to make sure that the images

 could be saved as the base file name.
• File: Since you may not upload only one image to the FTP server, you

can choose the filing rule, including Overwrite, Date/Time Suffix, and
set up the Sequence Number.

Manual Operation: When you click on the image upload On button, it will start
to upload the image. The setting refers to Base File Name and File information
above.

Save/Cancel:
After making sure all settings in the System are correct, click on Save to store
the settings for the Internet Camera. You can alternatively click on Cancel to
restore all settings to the values last saved to or retrieved from the Internet
Camera.
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System Administration - Information
The Information menu contains commands for displaying information about
the Internet Camera.

Click on “Information” in the system administration menu bar and the
Information screen will appear as illustrated below:

The Information table provides detailed information about the Internet Camera
such as the Model Name, Firmware Version, Mac Address, and IP Address.

System Administration - Tools
The Tools menu contains commands for restarting the Internet Camera.

Click on “Tools” in the system administration menu bar and the Tools screen
will appear as illustrated below:

Reset:
The Reset command restarts the Internet Camera. With Reset, you can turn it
off and then on again, with settings being retained. The Reset panel contains
the message “Do you really want to reset this device?” and a YES button. If you
do not want to reset the Internet Camera, exit the panel without clicking YES,
otherwise, click on the “YES” icon and the reset process will initiate.
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Factory Reset:
A factory reset restarts the Internet Camera and returns all of its settings to
their default values. The Factory Reset panel contains the message “Do you
really want to factory reset this device?” and a YES button. If you do not want to
carry out a factory reset command, exit the panel without clicking YES, otherwise
click on the “YES” icon and factory reset will be initiated.

Once the configuration is completed click on “Home” to return to the Home
screen and select the desired Viewing Image either through ActiveX Mode or
Java Mode as described in the next section.

The last step is to position the Internet Camera and adjust the  focus, by manually
turning the lens clockwise or counter-clockwise to the desired image quality.
Please refer to the appendix for detailed information regarding Adjusting the
Internet Camera Focus and Replacing the Lens.

View Image – ActiveX Mode
To view video images from the browser, click on “View Image – ActiveX Mode”
in the Home screen, as illustrated below:

**Location- The location of the Internet Camera will be displayed when the Location field is entered
in the Web Configuration settings under “System.”

*Camera Name - The Camera name will be displayed when the Camera Name field is entered in the Web
Configuration setting under “System.”

Note:
The Network settings must be reconfigured after a
Factory Reset!

***Date/Time - The date/time of the Internet Camera will show the date and time which comes either
from the time server or from settings you have made manually.

Camera Name*
Location**
Date/Time***
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Note:
Please refer to the appendix to learn how to install ActiveX.

1. Install to the Web Server
2. Install to your Local PC

In the View Image – ActiveX Mode you are allowed two output trigger options
and one image upload option.  Just click on the desired selection “ON” or
“OFF” to utilize the options for each of the functions.

Note 1:
Output trigger will send a 5V signal to the device connected to the Internet
Camera. A maximum of two devices is permitted to connect to Internet Camera
to utilize the output trigger function. Please refer to appendix for detailed
information.

Note 2:
The Administrator has the authority to allow users to set the output trigger
functions, through the Upload setting,  in the System Administration menu
bar.

View Image – Java Mode
Click on View Image – Java Mode from the Home screen to access the video
images from the Internet Explorer or Netscape browser as illustrated below:

Note 3:
The Administrator has the authority to allow users to set the image upload
functions through the Upload setting,  in the System Administration menu
bar.

Camera Name*
Location**
Date/Time***
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In the View Image – Java Mode you are allowed two output trigger options and
one image upload option. Just click on the desired selection ON or OFF to
utilize the options for each of the functions.

Note 1:
Output trigger will send a 5V signal to the device connected to the Internet
Camera. A maximum of two devices is permitted to connect to the Internet
Camera to utilize the output trigger function. Please refer to appendix for detailed
information.

Note 2:
The Administrator has the authority to allow users the permission to set the
output trigger functions through the  Users  setting in the System Administration
menu bar.

IPView Application Installation
Installation

To install the IPView application
click on the IPView button to acti-
vate the installation procedure for
the application program.

Date/Time*** - The date/time of the Internet Camera will show the date and time which
comes either from the time server or from manual settings.

Insert the CD-ROM into the CD-
ROM drive to initiate the auto-run
program.
A  menu screen will appear as
shown at right.

Camera Name* - The Camera name will be display when the Camera Name field is entered
in the Web Configuration setting under “System”
Location** - The location of the Internet Camera will be displayed when the Location field is
entered in the Web Configuration settings under “System.”

Note 3:
The Administrator has the authority to allow users to set the image upload
functions through the setting in the Upload in the System Administration menu
bar.
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Once executed a prompt will appear requesting the input of the desired language
selection. Make the desired selection and click on OK to continue.

The Welcome screen will appear. Click on the Next button to proceed with
the installation.
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The License Agreement prompt will appear as below.  Read the details carefully
and click on the Yes icon to continue with the installation procedure.
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The Select Program Folder prompt will appear providing information on where
the IPView application is located, click on Next to continue. If you wish to modify
your settings, click on Back to return to the previous screens.

                        

Please wait until one of the two dialog boxes appear, select  “Yes, I want to
restart my computer now” and click on Finish to restart the computer to
complete the installation procedure.
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or click on Finish to complete the installation procedure

                      

After successfully installing the IPView, the application program for the Internet
Camera is automatically installed to \Programs\Files Directory.

To start running the IPView click on windows Start > Menu > Programs >
IPView >IPView

Once IPView is executed a Login prompt will appear, you must enter the
default User Name: admin into the respective field and click on “OK” to log
into the application.
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Once logged in, the IPView application is executed and the IPView interface will
appear as follows in the default List View format:
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IPView - Getting Started
This section describes the operation of the IPView application user interface
with detailed procedures for using the application.

IPView
IPView is responsible for the management of preview, configuration, and
searching for each camera.

It is designed with a user-friendly interface for ease of control and navigation
as illustrated below.

List view format
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How to Change the Password

Change Password
When IPView is used for the first time it is highly recommended to change the
User Name and Password by the Administrator to constrain users access to
the IPView application. Once the User Name and Password are defined only
the Administrator has access to the management of IPView applications. This
procedure should be done as soon as possible to prevent unauthorized usage
of the IPView application.

Once IPView is executed a Login prompt will appear, you must enter the default
User Name: admin into the respective field and click on OK to log into the
application.

                              

To change the User Name and Password select Tools > Options. The
Options dialog box will appear as illustrated below.
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Enter a User Name, then enter the Password twice. Once all the new details
are entered click  OK.

Make sure to save any changes you have made to keep the information updated.

Note:
Alternatively you can click the Options icon  as illustrated or use the hot
key F10.

How to Add a Camera

Add Camera
In order to manage cameras in IPView, you must first add the cameras to IPView.
To add a new camera select Camera > Add from the IP View.  An Add Camera
dialog box will appear as illustrated below.

                                       

Enter the IP Address of the camera in the specified field and click Add. If the IP
Address is entered incorrectly a dialog box will appear to notify you of the error.

                                            

Note:  If you want to add a camera that is outside your LAN  and connected to
the Internet, you must key in a physical IP Address.
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Click on Search.  IPView will detect and search all the available cameras
that are installed on the local area network as depicted below:

Highlight the camera you wish to add and click on Add. The Add Camera
dialog box will appear once again with the IP Address entered. Click on Add.
The camera will be automatically be added into the IPView list view format.

If you are unsure of the IP Address of the camera you can click on Browse,
the Browse Camera dialog box will appear with a blank screen as illustrated
below.
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Alternatively, you can double-click on the camera you wish to add and the Add
Camera dialog box will appear once again with the IP Address entered. Click
on Add, and the camera will be automatically added into the IPView list view
format.

If the Login Camera dialog box appears,  make sure to enter the correct User
Name and Password.  Click OK.  The camera will be added into IPView, in list
format.  If the User Name and Password are entered incorrectly,  the camera
will not be added into IPView.

                            

The above dialog box will appear only if your have already set the User Name
and Password during the Web Configuration setting.

If you forget to highlight the camera you wish to add, a dialog box will appear to
notify you of the error.
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How to Delete a Camera

Delete Camera
To delete a camera you must highlight the camera you wish to delete from
IPView list view format. From the menu bar select Camera > Delete.  A Delete
Camera dialog box will appear.  Click Yes to delete the camera, or click  No if
you do not wish to delete the camera as illustrated below.

Make sure to save any changes you have made.

Note:
Alternatively you can click the Delete icon  as illustrated or use the hot
key Del.

Make sure to save any changes you have made.

Note 1:
You are only able to add one camera at a time.

Note 2:
Alternatively you can click the Add icon  as illustrated, or use the hot key
Shift+Ins.
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How to Change the IP Address

Change the IP Address
To change an IP Address for a camera, you must first locate the camera by
first selecting Camera > Add.  An Add Camera dialog box will appear as
illustrated below.

                         

Click on Browse, the Browse Camera dialog box will appear with a blank
screen as illustrated below.
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Click  Search.  IPView will detect and search all the available cameras that
are installed on the local area network as depicted below:

                           

Highlight the camera you wish to change and click  Change IP.  The Change
IP Address dialog box will appear as depicted below:

Enter the new IP Address, the Subnet Mask and the Default gateway into the
respective fields and click OK.   IPView will automatically change the IP Address.

Make sure to save any changes you have made.
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How to Format the Camera View
View Camera
From the menu bar select View > 4 Cameras (other choices are available in 1
Camera, 9 Cameras and 16 Cameras viewing format).  The viewing screen
will appear with the video image.

Note:
The icon on the upper left corner of the screen will appear with the camera
number that is being displayed

To return to the IPView list view format, right-click on the icon located on the
upper left corner of the screen and a case sensitive menu will appear. Select
List and the viewing image will return to the list view format.

Note 1:
A maximum of 16 cameras are available for viewing with the IPView
application.

Note 2:
Alternatively you can click the 1 Camera icon  as illustrated or use the hot

key Ctrl+F3.  For 4 Cameras , 9 Cameras and 16 Cameras  click
the respective icon or use the hot key as follows Ctrl+F4, Ctrl+F5 and Ctrl+F6.
To return to list view format use the hot key Ctrl+F1.
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Rotate Video
In View Mode format, click on the icon located on the upper left corner of the
screen and a pop-up menu will appear as shown below.

Once you click Rotate Right or Rotate Left in the menu, the video will rotate
90 degrees to the right or left.

How to take a Snap-Shot with the Camera
Snap shot

To take a snap shot with the camera, you must highlight the camera you wish
to use from the list view format. From the menu bar select Camera > Snap
shot.  A Save Image dialog box will appear for you to save the snap shot
picture.
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Alternatively, select from the viewing mode either 1, 4, 9, or 16 cameras.  Click
on the icon located on the upper left corner of the screen.  A case sensitive
menu will appear.  Select the Snap shot icon.  A Save Image dialog box will
appear for you to save the snap shot picture.

Note:
You can also click the Snap shot icon , as illustrated, or use the hot key,
F5.

How to Start Recording

To start recording with a camera you must highlight the camera you want to use
from the list view format.  From the menu bar select Camera > Start.  According
to the default setting, an AVI file will appear in your IPView folder to save the
recorded videos.

Alternatively, in the viewing mode (using either 1, 4, 9, 16 cameras), right-click
on the icon located on the upper left corner of the screen.  A case sensitive
menu will appear.  Select the Start  icon. According to the default setting, an AVI
file will appear in your IPView folder to save the recorded videos.

Note :
Please stop recording before you want to change any setting in the internet
camera. Alternatively you can click the Start icon  as illustrated or use the hot
key "F7".  If you are using Windows Media Viewer to view your recorded videos,
make sure that you have the most up-to-date version to view the videos correctly.

How to Stop Recording

To stop recording with a camera, you must highlight the camera you wish to
stop from the list view format. From the menu bar select Camera > Stop. The
recording function will be stopped.

The other alternative is to right-click the icon located on the upper left corner of
the screen under the viewing mode of either 1, 4, 9, 16 cameras; a pop-up
menu will appear.  Select Stop.  The recording task will be stopped.

Note :
Alternatively you can click the Stop icon   as illustrated or use the hot key "F9".
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How to Adjust the Property Setting
Property is initiated by selecting Camera > Property.   A dialog box will appear
which allows for Web Configuration settings and upgrading firmware. (Please
refer to the appendix for detailed information.) The Camera Property dialog
box will appear.  Select the desired options from the tab selections to Configure
the camera as shown below.

General
Allows settings for the camera name, location and administrator information
such as administrator ID and password. Please refer to the Web Configuration
section under System Administration – System for further details.
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IP Assignment
There are two options: Manually Assign or Assign Automatically Using.
(Please refer to the Web Configuration section: System Administration –
System for further details.)
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DNS
DNS (Domain Name System) server is an Internet service that translates domain
names into IP addresses. Enter at least one DNS IP Address. Please refer to
the Web Configuration section under System Administration – System for
further details.
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Wireless - (For Wireless Internet Camera only)
Allows for the settings for Connection mode, Network name, Wireless
Channel and WEP key.  Please see the Web Configuration section under
System Administration-System for further details.
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Misc
Allows setting for LED Control, ActiveX control location, and second port. (Please
refer to the Web Configuration section under System Administration – System
for further details.)

Image
Provides the settings for the video image of the camera such as brightness,
contrast, hue, resolution, compression, frame rate, and light freq. (Please refer
to the Web Configuration section under System Administration – Image for
further details.)
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Users
Allows the system administrator to allow or deny users permission to monitor
the camera from a remote site by using  Add or Delete user.

To add a user click on the Add icon and the Add User dialog box will appear.
Enter the User Name and Password into the specific field. Select the I/O Output
Control to give users the privilege of accessing the I/O Output Control.

                                           

To delete a user, select the user and click on the Delete icon.

(Please refer to the Web Configuration section under System Administration
– Users for further details.)
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Date/Time
Set the camera’s time and date to provide correct time information to users
who might be thousands of miles away in a remote site by selecting
Synchronized with Time Server or Set Manually.  (Please refer to the Web
Configuration section under System Administration – TimeDate for further
details.)

Trigger 1
Contains commands for setting the Input/Output Trigger connectors providing
the physical interface for 1 digital output and 1 digital input that is used for
connecting a diversity of external alarm devices to the camera such as IR-
Sensor and alarm relay. (Please refer to the Web Configuration section under
System Administration – Trigger for further details.)
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Trigger 2
Contains commands for setting the Input/Output Trigger connectors that
provide the physical interface for 1 digital output and 1 digital input, used for
connecting a diversity of external alarm devices to the camera such as IR-
Sensor and alarm relay. (Please refer to the Web Configuration section under
System Administration – Trigger for further details.)

Information
Displays information about the camera such as the model, firmware version,
MAC address, and IP address. (Please refer to the Web Configuration section
under System Administration – Information for further details.)
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Tools
Contains commands to reset the camera and update firmware (please refer to
the appendix for detailed information). Please refer to the Web Configuration
section under System Administration – Tools for further details on reset.
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Recording
The software will create a camera name folder in the File Path specified and
record the video images with file name by date and time.  You can adjust the
maximum file size by clicking on By Size from the Recording Options field.
(The default size is 50MB.) If the recorded video files reach the file size allocated,
video images will be recorded into another file automatically. Click on By Time
in Recording Options if you wish to record to a file for a specified time period.
Once the time period specified is reached, video images will be recorded into a
new file automatically.

Make sure to save any changes you have made to keep the information updated.
Note:
If you are using Windows Media Viewer to view your recorded videos, make
sure that you have the most up-to-date version to view the videos correctly.
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Schedule
Allows customized settings to start recording specified by date or by week. Check
the Recording Schedule box to enable this option.  Select By Date and enter
in the dates, Stop, and Start Times.  The camera will start to record according to
the specified date and time period entered.  Select By Week to indicate specific
days to record and the time period.

Motion Detection
This menu sets up motion detection for the camera.  Click on Motion Detection
to enable motion detection.  Click on Alarm Beep to enable audio notification
once motion is detected and Recording Active to start recording once motion is
detected. The Sensitivity Level can also be adjusted.  Be sure to Apply your
settings and click on OK to exit this menu and save your changes.
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Motion Detection (List View)
In the list view for the camera, a red circle preceeding  the camera name indicates
that the camera detected motion and is recording.  The Camera will continue to
record for 10 seconds after it has stopped detecting motion, then will stop
recording.  A new .AVI file will appear in your recording folder that you specified
each time the camera is triggered to record.  In the Camera menu, a check mark
in front of Enable Motion indicates that the camera is detecting motion and is
recording.  You can manually disable motion detection by clicking on Stop and
clicking on Enable Motion, which will remove the check mark.

To re-enable motion detection, simply click on Enable Motion and a check
mark will appear to indicate that the camera is now set to record when it detects
motion.
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Menu Bar

The menu bar provides easier access for users to navigate the IPView with
different selections along with hot key capabilities as follows:

Menu Bar - File

File on the menu bar contains New, Open, Save, Save As and Exit for users
to create new files, open existing files, save files, and exit the IPView as depicted
below.
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Menu Bar – View
View on the menu bar provides users with management capabilities for
Columns, List, Camera and Refresh. You can view the Camera in 1
Camera, 4 Cameras, 9 Cameras, or 16 Cameras mode. The View menu
bar is pictured below.

Columns
When Columns is launched, a dialog box will appear displaying the Column
Settings.  Select the columns that you wish to appear in List View as
illustrated below.

Viewing Format
You can view the format in List view. The List viewing format allows easy
management and control of each camera.
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List View
All the cameras and their properties, such as the camera name, IP address,
user name, and location, will be displayed in the list view.

Note:
Right click on any camera to bring up a context sensitive menu of actions you
can apply to the selected camera.

Double-clicking on the desired camera will bring up the Property dialog box.

You can click the Refresh icon to update the camera list view.



67

Menu Bar - Camera
Camera on the menu bar provides options to manage the camera. Add up to 16
additional Cameras for viewing. The Camera menu also allows you to Delete a
camera, manage the Property, Enable real timevideo capture, take a Snap
shot image, and Enable Motion for Motion Detection. The menu bar is
illustrated below:

Enable Function
By default the video image is enabled. There will be a check next to the Enable
command to show that the Enable function is working. To disable the real-time
image select Camera > Enable and the real-time video image will stop and
shutdown.

Menu Bar - Tools
Tools on the menu bar allows you to change account information and system
configuration. From the menu bar, select Tools> Options.
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Menu Bar - Help
Under Help on the menu bar you can choose Contents or About to learn more
about the camera.

Overwrite
Allows old video files to be overwritten and replaced by new recorded files.
Choose Overwrite (Time) to have video clips recorded in the time frame
specified overwritten with new recorded files. Choose Overwrite (Space) to

Account
Allows you to change your log in name and password.

overwrite old files with new recorded files once the disk drive reaches the specified
drive space.
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IPView Icon Description

 Open a new file.  The hot key is Ctrl+N.

 Open an existing file.  The hot key is Ctrl+O.

 Save a file. The hot key is Ctrl+S.

 List view format. The hot key is Ctrl+F1.

 1 Camera view format.  The hot key is Ctrl+F3.

 4 Camera view format.  The hot key is Ctrl+F4.

 9 Camera view format. The hot key is Ctrl+F5.

 16 Camera view format.  The hot key is Ctrl+F6.

 Refresh IPView application. The hot key is F12.

 Add a camera.  The hot key is Shift+Ins.

 Delete a camera.  The hot key is Del.

 Property setting to configure the camera.  The hot key is F2.

 Snap shot to capture a single still image. The hot key is F5.

 Options to modify the User Name and Password for IPView.
      The hot key is F10.

 Start recording video image.  Alternatively the hot key is F7. 

 Stop recording video image.  Alternatively the hot key is F9.
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Context Sensitive Menu
In List View format, highlight a camera and right-click to bring up a context
sensitive menu for features such as Add, Delete, Property, Enable, and Snap
shot, Enable Motion, and Start/Stop recordings.

In View mode format click on the icon located on the upper left corner of the
screen and a case sensitive menu will appear as illustrated below.

These features will be available: Enable, Rotate Right, Rotate Left, Snap
Shot, Enable Motion, Start,  List, 1 Camera, 4 Cameras, 9 Cameras, 16
Cameras, Previous Page and Next Page.
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Click on windows Start Menu / Programs / IPView / Uninstall IPView. A
new prompt screen will be displayed like the one below confirming the
removal.

Choose the option that you want and click Next to continue the process or click
on Cancel  to reject the uninstall process.

After you click on Next, a Confirm Uninstall dialog box will appear.  Click OK
to continue the process.

Uninstall IPView Application
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The InstallShield Wizard prompt will appear.  Click  Finish to complete the
uninstallation procedure.
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Appendix
Frequently Asked Questions
Internet Camera Features
Q: What is an Internet Camera?
A:The Internet Camera is a standalone system connecting directly to an Ethernet
or Fast Ethernet network and supported by the wireless transmission based
on the IEEE 802.11b standard. It is different from the conventional PC Camera,
the Internet Camera is an all-in-one system with built-in CPU and web-based
solutions providing a low cost solution that can transmit high quality video images
for monitoring. The Internet Camera can be managed remotely, accessed and
controlled from any PC/Notebook over the Intranet or Internet via a web browser.

Q: What is the maximum number of users that can be allowed to access
DCS-1000W simultaneously?
A: Maximum number of users that can log onto the Internet Camera at the
same time is 64. Please keep in mind the overall performance of the transmission
speed will slow down when many users are logged on.

Q: What algorithm is used to compress the digital image?
A: The Internet Camera utilizes JPEG image compression technology providing
high quality images. JPEG is a standard for image compression and can be
applied to various web browser and application software without the need to
install extra software.

Q: Can I change the wireless antenna attached to the Internet Camera?
A: The wireless antenna can be changed for a variety of reasons such as
extending the wireless transmission range, however, please consult authorized
distributors before attempting as the connectors must be SMA connector type.

Q: Can I capture still images from the Internet Camera?
A: Yes you are able to capture still images with the snapshot function from
the IPView application supplied with the Internet Camera CD-ROM. You may
also use the first page that shows up with you type in the IP address of the
camera. When viewing this page, press the “refresh” button on your web
browser to update the image. Please refer to the User’s Guide for detailed
information.
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Q: What is the wireless transmission range for the Internet Camera?
A: Generally the wireless distance can go up to 100 meters indoors and up to
300 meters outdoors. The range is limited by the number of walls, ceilings, or
other objects that the wireless signals must pass through. Typical ranges vary
depends on the types of materials and background Radio Frequency (RF) noise
in your home or business and the configuration setting of your network
environment.

Internet Camera Installation
Q: Can the Internet Camera be used outdoors?
A: The Internet Camera is not weatherproof. It needs to be equipped with a
weatherproof case to be used outdoors and it is not recommended.

Q: What network cabling is required for the Internet Camera?
A: The Internet Camera uses Category 5 UTP cable allowing 10 Base-T and
100 Base-T networking.

Q: Can the Internet Camera be setup as a PC-cam on the computer?
A: No, the Internet Camera is used only on Ethernet and Fast Ethernet network
and supported by wireless transmission. The D-Link DSB-C100, DSB-C300,
DSC-350 or DSC-350F can be used as a PC Camera (Webcam).

Q: Can the Internet Camera be connected on the network if it consists of
only private IP addresses?
A: The Internet Camera can be connected to a LAN with private IP addresses.

Q: Can the Internet Camera be installed and work if a firewall exists on
the network?
A: If a firewall exists on the network, port 80 is open for ordinary data
communication. However, since Internet Camera transmits image data, the
default port 8481 is also required. Therefore, it is necessary to open port 8481
of the network for remote users to access the Internet Camera.

Troubleshooting

Q: I cannot access the Internet Camera from a web browser?
A1: The possible cause might be the IP Address for the Internet Camera is
already being used by another device. To correct the possible problem, you
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need to first disconnect the Internet Camera from the network. Then run the
PING utility (follow the instructions in Appendix B - PING Your IP Address.)

A2: Another possible reason is the IP Address is located on a different subnet.
To fix the problem, run the PING utility (follow the instructions in Appendix B -
PING Your IP Address). If the utility returns “no response” or similar, the finding
is probably correct, then you should proceed as follows:

In Windows 95/98/2000 and Windows NT, check that the IP Address of the
Internet Camera is within the same subnet as your workstation.

Click Start, Setting, Control Panel, and the Network icon.
Select TCP/IP from the Network dialog box and from the TCP/IP
Properties dialog box click on Specify an IP address.
If the Internet Camera is situated on a different subnet than your
workstation, you will not be able to set the IP address from this workstation.
To verify make sure the first 3 sections of the IP address of the Internet
Camera corresponds to the first 3 sections of the workstation. Therefore
the IP address of the Internet Camera must be set from a workstation on
the same subnet.

A3: Other possible problems might be due to the network cable. Try replacing
your network cable. Test the network interface of the product by connecting a
local computer to the unit, utilizing a standard Crossover (hub to hub) Cable. If
the problem is not solved the Internet Camera might be faulty.

Q: Why does the Power LED not light up constantly?
A: The power supply used might be at fault. Confirm that you are using the
provided power supply, which is DC 5V, for the Internet Camera and verify that
the power supply is well connected.

Q: Why does the LAN/WLAN LED not light up properly?
A1: There might be a problem with the network cable. To confirm that the cables
are working, PING the address of a know device on the network. If the cabling
is OK and your network is reachable, you should receive a reply similar to the
following (…bytes = 32 time = 2 ms).

A2: The network device utilized by the Internet Camera is not functioning properly,
such as hubs or switches. Confirm the power for the devices are well connected
and functioning properly.
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A3: The wireless connection might be at fault. In ad-hoc mode make sure the
Internet Camera wireless channel and ESS-ID is set to match the PC/Notebook
wireless channel and ESS-ID for direct communication. Since The Internet
Camera ad-hoc mode supports two modes (802.11 ad-hoc mode and
proprietary ad-hoc mode), make sure that you are using the same mode on
each device. If they are not the same, the camera will not be accessible.

Under infrastructure mode make sure the ESS-ID on the PC/Notebook and the
Internet Camera must match with the Access Point’s ESS-ID.

Q: Why does the Internet Camera work locally but not externally?
A1: Might be caused from the firewall protection. Check the Internet firewall
with your system administrator. The firewall may need to have some settings
changed in order for the Internet Camera to be accessible outside your local
LAN.

A2: Make sure that the Internet Camera isn’t conflicting with any web server
you may have running on your network.

A3: The default router setting might be a possible reason. Check that the
configuration of the router settings allow the Internet Camera to be accessed
outside your local LAN.

Q: Why does a series of broad vertical white line appear through out the
image?
A: It could be that the CMOS sensor has become overloaded when it has been
exposed to bright lights such as direct exposure to sunlight or halogen lights.
Reposition the Internet Camera into a more shaded area immediately as
prolonged exposure to bright lights will damage the CMOS sensor.

Q: The focus on the Internet Camera is bad, how can I correct it?
A1: Adjust the Internet Camera focus manually as described in “Adjusting the
Internet Camera Focus” in the Appendix section of this manual.

A2: If you have previously changed the supplied CS-type lens, you may have
unintentionally installed a C-type lens without fitting the adaptor first.

Q: Noisy images occur. How can I solve the problem?
A1: The video images might be noisy if the Internet Camera is used in a very
low light environment. To solve this issue you need more lighting.
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A2: There might be wireless transmission interference. Make sure there are no
other wireless devices on the network that will affect the wireless transmission.

Q: The images is of poor quality, how can I improve the image quality?
A1: Make sure that your computers display properties are set to at least 15-
bit color. Using 16 or 256 colors on your computer will produce dithering
artifacts in the image, making the image look as if it has bad quality.

A2: The configuration on the Internet Camera image display is incorrect. Through
the Web Configuration Image section of the web management you need to
adjust the image related parameter for improve images such as brightness,
contrast, hue and light frequency. Please refer to the Web Configuration section
for detail information.

Q: There are no images available through the web browser?
A1: The ActiveX might be disabled. If you are viewing the images from Internet
Explorer make sure ActiveX has been enabled in the Internet Options menu.
Alternatively, you can use the Java Applet for viewing the required images.

A2: If you are using Windows XP, please make sure that you have downloaded
Java and installed it properly.

A3: Make sure that your web browser supports Java. If you are using Internet
Explorer or Netscape Navigator with a version number of lower than 4, then you
will need to upgrade your web browser software in order to view the streaming
video transmitted by the Internet Camera.

How to PING Your IP Address
The PING (Packet Internet Groper) command can determine whether a specific
IP address is accessible by sending a packet to the specific address and waiting
for a reply. It can also provide a very useful tool to confirm if the IP address
conflicts with Internet Camera over the network.

Follow the step-by-step procedure below to utilize the PING command but first
you must disconnect Internet Camera from the network.

Start a DOS window.
Type ping x.x.x.x, where x.x.x.x is the IP address of the Internet Camera.

Four successive “Reply from” statements indicate connectivity.
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I/O Connector

I/O Connector Definition for the Internet Camera
An 8-pole connector is provided for auxiliary I/O connections to the Internet
Camera.

The I/O connector provides the physical interface for 2 digital outputs and 2
digital inputs that are used for connecting a diversity of external alarm devices
to the Internet Camera such as IR-Sensor and alarm relay.

The digital input is used for connecting external alarm devices and once triggered
images will be taken and e-mailed.

The supported transistor output can give a maximum of DC 5V to the externally
connected alarm devices and once triggered the current will activate the devices.

In 11
In 12

In 21
In 22

Out 1 -
Out 1 +

Out 2 -
Out 2 +

In 11 & In 12 is a pair for digital input.  It works at voltage 5V.

In 21 & In 22 is a pair for digital input.  It works at voltage 5V.

Out 1+ & Out 1-  is a pair for digital output.  The output voltage
is 5V and the maximum current is 100mA.

Out 2+ & Out 2 -  is a pair for digital output.  The output voltage
is 5V and the maximum current is 100mA.
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I/O Schematic Diagram

Warning
1. When connecting a device to the Input connector, the device must be a passive

component without voltage and electrical current.
2. When connecting other devices through the Output connector, please make

sure the maximum current of DC 5V, 100mA is strictly observed.
3. Any failure of the above two points might cause serious damage to the camera.

Note:
Through the Web Configuration in the Trigger section, you must first enable
the trigger function. Please refer to the Web Configuration section for de-
tailed information.

voltage 5V.

voltage 5V.
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Upgrade Firmware
You can update the firmware from the IPView application. With IPView running,
select Camera > Properties and the Camera Property dialog box will appear.
Select the Tools tab and enter the full path of the firmware binary file name in
the Update Firmware field or you can click on the Browse button to select the
file. Once the firmware file is entered click on the Update button to proceed
with the update process. Once completed, click OK as illustrated below:

Warning
The download firmware procedure cannot be
interrupted. If the network connection is broken during
the download procedure it might possibly cause
serious damage to the Internet Camera.
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Time Zone Table
GMT stands for Greenwich Mean Time, which is the global time that all
time zones are measured from.
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Xplug Control Installation
Installation to a Web Server

It is highly recommended to install the Xplug Control application to the
Web Server for IE 5.0. It must be installed to a Public Domain with a
Fixed IP address.

Important Information

1. Installation:
Copy the “xplug.ocx” file to any Web Server table. Note the web address
of the file location so that you can use it in the next step.

2. Configuration:
From the Web Configuration menu select “System” and under the
“Loading ActiveX From” input web server location
(http://www.web server location.com/).

Once the settings are completed you should now be able to access the Internet
Camera from the web browser by selecting ActiveX mode.

Note:
Set your browser security level to “Low” so that your browser will allow ActiveX
control of the camera.
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Installation to a Local PC
Insert the CD-ROM into the CD-ROM drive to initiate the auto-run program.
Once completed a menu screen will appear as follows:

To install Xplug Control click on the “Xplug Control” button to activate the
installation procedure for the plug-in program.
Once executed a prompt will appear requesting the input of the desired language
selection. Make the desired selection and click on “OK” to continue.
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The Welcome screen will appear. Click  Next to proceed with the installation.

The License Agreement prompt will appear as below. Read the details
carefully and click Yes to continue with the installation procedure.
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Click Finish to complete Setup of the Xplug Control Utility program for the
Internet Camera.

Adjusting the Cameras Focus
The Internet Camera features an exchangeable C/CS-type lens that can be
used for different applications as necessary. It supports rotational focus control
so the lens can be adjusted to focus under normal and stable conditions to
maximize the image quality of the Internet Camera.

To adjust the focus of the lens you will need to turn the lens slowly either
clockwise or counter-clockwise until the desired image appears. DO NOT over-
turn the lens in either direction as it will be out of focus. Unless you want to
substitute the lens DO NOT unscrew more than 1.0mm apart from the Fixed
Lens Assembly.

To help you get the best image quality, keep in mind that while adjusting the
DCS-1000W’s focus you can preview the image quality from your Web browser.

Please refer to the diagram on the next page when adjusting the camera lens.
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Camera Lens
Adjust by turning
clockwise or counter-clockwise

Fixed Lens Assembly
DO NOT adjust

Note:
You can further adjust the Internet Camera’s image quality
through the Web Configuration under System Administration -
Image. Please refer to Web Configuration section for further
details.

Warning

Direct exposure to sunlight may cause permanent damage to the
CMOS sensor. Therefore do not expose the Internet Camera’s lens
directly to sunlight. When operation is required in glaring light envi-
ronment, it is recommended to use an iris lens.

The Internet Camera is designed for indoor usage and if your appli-
cation requires prolonged exposure to sunlight, a sun visor is rec-
ommended to protect the Internet Camera.
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Replacing the Lens
Since the Internet Camera is designed with a CS- mount, the lens equipped
with the Internet Camera can be replaced with any standard C or CS lens
commonly used within the surveillance industry.

Follow the instructions below to replace the supplied lens with any C or CS
type lens.

1. Unscrew the Internet Camera lens
2. When using a C-lens, attach the new lens to a CS-C adapter
3. Screw the new lens onto the Internet Camera. If appropriate, adjust the iris

according to the prevailing light conditions.
4. Refer to Adjusting the Internet Camera Focus on the previous page.
5. Refresh the web browser and monitor the results from the Internet Camera.
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Technical Specifications
Video specification
Resolution: 640 x 480 pixel
Sensor: 1/3" color CMOS sensor
Gain control: Automatic
Exposure: Automatic
White Balance: Automatic
Shutter: Electronics 1/60 ~ 1/15000 sec
Minimum Illumination: 2.5lux@f1.4, 3000K color
Focal Length: 6.0 mm
Aperture: F=1.8
Focus Extent: 20 cm - “
Lens mounting: Fixed board lens, CS-mount type

Image (Video Setting)
Image compression: JPEG
Frame rate: 30fps@QCIF, 20fps@CIF, 3fps@VGA
Compression Rate selection: 5 level (Very Low, Low, Medium, High, Very

High)
Frame rate setting: 1, 5, 7, 15, 20, auto (depends on the video

format)
Video resolution: 160x120, 320x240, 640x480
Brightness control: Range 1- 128
Contrast control: Range 1- 128
Hue control: Range 1- 128

System Hardware
LAN Connector: One RJ-45 port to connect to 10/100Mbps

Ethernet, auto-sensed
Wireless LAN: Built-in 802.11b wireless LAN module

(Wi-Fi compliant)
Generic I/O Port: Four I/O ports, two for input and two for output

Total 8-pin:
      Pin 1  Input Port (I+) Pin 5  Output Port (I+)
      Pin 2  Input Port (I-)   Pin 6  Output Port (I-)
      Pin 3  Input Port (II+) Pin 7  Output Port (II+)
      Pin 4  Input Port (II-)  Pin 8  Output Port (II-)

Note:
The output voltage is DC 5V and maximum current is 100mA.
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LED Indicator: Power LED (Blue)
LAN/WLAN Activity LED (Orange)

Note:
LED three mode setting can be changed by software. (Normal / Off /
Dummy)
Power Supply: DC 5V/2.4A, switching type
Power Communication: 6.5 Watt (1300mA x 5V)
Slide Switch: LAN/LAN&WLAN/WLAN
Antenna Connector: 2 connectors

Communication Support
Communication: 10/100Mbps Ethernet only

10/100Mbps Ethernet and 802.11b wireless
LAN.
802.11b wireless LAN only

Encryption: 64 bit, 128 bit or OFF
Communication protocol: HTTP, FTP, TCP/IP, UDP, ARP,

ICMP, BOOTP, RARP, DHCP, PPPoE

Web Configuration Requirements:

• Internet Explorer 5.0 or above or Netscape 6.0 or above
• CPU: Pentium II, 266 MHz or above
• Memory Size:32 MB (64 MB recommended)
• VGA card resolution:800x600 or above
• ActiveX Control requires IE4.0 or above (windows)
• Java Applet requires IE4.0 or above (Windows/Mac) or Netscape

4.0 or above (Windows/Mac/Linux)

PC Requirements for IPView:

• Windows XP, Windows 2000, Windows Me, Windows 98SE/98
• Pentium III, 450 MHz CPU or above
• Memory Size of 128 MB (256 MB recommended)
• VGA card resolution of 800x600 or above

Operating environment
Operating temperature: 5° ~ 50°
Storage temperature: -25° ~ 50°
Humidity: 5% ~ 95% non-condensing

EMI & Safety FCC, CE, VCCI
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You can find the most recent software and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States for the
duration of the warranty period on this product.

U.S. customers can contact D-Link technical support through our web site,
or by phone.

D-Link Technical Support over the Telephone:
• (877) 453-5465
• 24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
• http://support.dlink.com

When contacting technical support, please provide the following information:

• Serial number of the unit
• Model number or product name
• Software type and version number

Contacting Technical Support
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Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

• D-Link or its authorized reseller or distributor and
• Products purchased and delivered within the fifty states of the United States, the District of

Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an
APO or FPO.

Limited Warranty:  D-Link warrants that the hardware portion of the D-Link products described
below will be free from material defects in workmanship and materials from the date of original retail
purchase of the product, for the period set forth below applicable to the product type (“Warranty
Period”), except as otherwise stated herein.
1-Year Limited Warranty for the Product(s) is defined as follows:

• Hardware (excluding power supplies and fans) One (1) Year
• Power Supplies and Fans One (1) Year
• Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period
at no charge to the original owner or to refund at D-Link’s sole discretion.  Such repair or replacement will
be rendered by D-Link at an Authorized D-Link Service Office.  The replacement Hardware need not be
new or have an identical make, model or part.  D-Link may in its sole discretion replace the defective
Hardware (or any part thereof) with any reconditioned product that D-Link reasonably determines is
substantially equivalent (or superior) in all material respects to the defective Hardware.  Repaired or
replacement Hardware will be warranted for the remainder of the original Warranty Period from the date
of original retail purchase.  If a material defect is incapable of correction, or if D-Link determines in its sole
discretion that it is not practical to repair or replace the defective Hardware, the price paid by the original
purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of the defective
Hardware.  All Hardware (or part thereof) that is replaced by D-Link, or for which the purchase price is
refunded, shall become the property of D-Link upon replacement or refund.
Limited Software Warranty:  D-Link warrants that the software portion of the product (“Software”)
will substantially conform to D-Link’s then current functional specifications for the Software, as set forth
in the applicable documentation, from the date of original retail purchase of the Software for a period of
ninety (90) days (“Warranty Period”), provided that the Software is properly installed on approved
hardware and operated as contemplated in its documentation. D-Link further warrants that, during the
Warranty Period, the magnetic media on which D-Link delivers the Software will be free of physical
defects.  D-Link’s sole obligation shall be to replace the non-conforming Software (or defective media)
with software that substantially conforms to D-Link’s functional specifications for the Software or to
refund at D-Link’s sole discretion.  Except as otherwise agreed by D-Link in writing, the replacement
Software is provided only to the original licensee, and is subject to the terms and conditions of the
license granted by D-Link for the Software.  Software will be warranted for the remainder of the original
Warranty Period from the date or original retail purchase.  If a material non-conformance is incapable of
correction, or if D-Link determines in its sole discretion that it is not practical to replace the non-
conforming Software, the price paid by the original licensee for the non-conforming Software will be
refunded by D-Link; provided that the non-conforming Software (and all copies thereof) is first returned
to D-Link.  The license granted respecting any Software for which a refund is given automatically
terminates.
Non-Applicability of Warranty:  The Limited Warranty provided hereunder for hardware and software
of D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers,
or the liquidators expressly disclaim their warranty obligation pertaining to the product and in that case,
the product is being sold “As-Is” without any warranty whatsoever including, without limitation, the
Limited Warranty as described herein, notwithstanding anything stated herein to the contrary.
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Submitting A Claim:  The customer shall return the product to the original purchase point based on its
return policy.  In case the return policy period has expired and the product is within warranty, the
customer shall submit a claim to D-Link as outlined below:

• The customer must submit with the product as part of the claim a written description of the
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm
the same.

• The original product owner must obtain a Return Material Authorization (“RMA”) number from
the Authorized D-Link Service Office and, if requested, provide written proof of purchase of
the product (such as a copy of the dated purchase invoice for the product) before the
warranty service is provided.

• After an RMA number is issued, the defective product must be packaged securely in the
original or other suitable shipping package to ensure that it will not be damaged in transit, and
the RMA number must be prominently marked on the outside of the package.  Do not include any
manuals or accessories in the shipping package.  D-Link will only replace the defective portion
of the Product and will not ship back any accessories.

• The customer is responsible for all in-bound shipping charges to D-Link.  No Cash on Delivery
(“COD”) is allowed.  Products sent COD will either be rejected by D-Link or become the
property of D-Link.  Products shall be fully insured by the customer and shipped to D-Link
Systems, Inc., 53 Discovery Drive, Irvine, CA 92618.  D-Link will not be held responsible
for any packages that are lost in transit to D-Link.  The repaired or replaced packages will be
shipped to the customer via UPS Ground or any common carrier selected by D-Link, with
shipping charges prepaid. Expedited shipping is available if shipping charges are prepaid by
the customer and upon request.

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the
foregoing requirements, or for which an RMA number is not visible from the outside of the package. The
product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product
that is not packaged and shipped in accordance with the foregoing requirements, or that is determined
by D-Link not to be defective or non-conforming.
What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced
or removed; Initial installation, installation and removal of the product for repair, and shipping costs;
Operational adjustments covered in the operating manual for the product, and normal maintenance;
Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;
Any hardware, software, firmware or other products or services provided  by anyone other than D-
Link; Products that have been purchased from inventory clearance or liquidation sales or other sales in
which D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the
product.  Repair by anyone other than D-Link or an Authorized D-Link Service Office will void this
Warranty.
Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN ANY TERRITORY
WHERE A PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO
NINETY (90) DAYS. EXCEPT AS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED
HEREIN, THE ENTIRE RISK AS TO THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS
WITH THE PURCHASER OF THE PRODUCT.
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Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE
UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY
FOR ANY LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER,
WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO,
DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER
FAILURE OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-
LINK’S PRODUCT IS CONNECTED WITH, LOSS OF INFORMATION OR DATA CONTAINED IN, STORED ON,
OR INTEGRATED WITH ANY PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING
FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY
BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE FOREGOING LIMITED WARRANTY IS
REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT.  THE MAXIMUM
LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT
COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIES AND REMEDIES
ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR
STATUTORY
Governing Law:  This Limited Warranty shall be governed by the laws of the State of California. Some
states do not allow exclusion or limitation of incidental or consequential damages, or limitations on how
long an implied warranty lasts, so the foregoing limitations and exclusions may not apply. This limited
warranty provides specific legal rights and the product owner may also have other rights which vary
from state to state.

Trademarks:  D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement:  No part of this publication or documentation accompanying
this Product may be reproduced in any form or by any means or used to make any
derivative such as translation, transformation, or adaptation without permission from
D-Link Corporation/D-Link Systems, Inc., as stipulated by the United States Copyright
Act of 1976.  Contents are subject to change without prior notice.  Copyright© 2002 by
D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning:  This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement:  This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communication. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.
• Consult the dealer or an experienced radio/TV technician for help.
Register online your D-Link product at http://support.dlink.com/register/Register online your D-Link product at http://support.dlink.com/register/Register online your D-Link product at http://support.dlink.com/register/Register online your D-Link product at http://support.dlink.com/register/Register online your D-Link product at http://support.dlink.com/register/
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